Learning Module 9
Drop Test

Title Page Guide

What is a Learning Module?

A Learning Module (LM) is a structured, concise, and self-sufficient learning resource. An LM provides the learner with the required content in a precise and concise manner, enabling the learner to learn more efficiently and effectively. It has a number of characteristics that distinguish it from a traditional textbook or textbook chapter:

- An LM is learning objective driven, and its scope is clearly defined and bounded. The module is compact and precise in presentation, and its core material contains only contents essential for achieving the learning objectives. Since an LM is inherently concise, it can be learned relatively quickly and efficiently.
- An LM is independent and free-standing. Module-based learning is therefore non-sequential and flexible, and can be personalized with ease.

Presenting the material in a contained and precise fashion will allow the user to learn effectively, reducing the time and effort spent and ultimately improving the learning experience. This is the first module on structural analysis and covers a static structural study in FEM. It goes through all of the steps necessary to successfully complete an analysis, including geometry creation, material selection, boundary condition specification, meshing, solution, and validation. These steps are first covered conceptually and then worked through directly as they are applied to an example problem.

Estimated Learning Time for This Module

Estimated learning time for this LM is equivalent to three 50-minute lectures, or one week of study time for a 3 credit hour course.

How to Use This Module

The learning module is organized in sections. Each section contains a short explanation and a link to where that section can be found. The explanation will give you an idea of what content is in each section. The link will allow you to complete the parts of the module you are interested in, while being able to skip any parts that you might already be familiar with. The modularity of the LM allows for an efficient use of your time.
1. Learning Objectives

The objective of this module is to introduce the user to the process of Shape Optimization using FEM. Upon completion of the module, the user should have a good understanding of the necessary logical steps of a Shape Optimization simulation, and be able to perform the following tasks:

- Drop Test
- Key concepts in Drop Test
- Objective
- Impact analysis
- Dynamics
- Kinematics
- Displacement
- Velocity
- Acceleration

2. Prerequisites

In order to complete the learning module successfully, the following prerequisites are required:

- By subject area:
  - Kinematics
  - Dynamics
- By topic:
  - Knowledge of
    - Acceleration
    - Velocity
    - Displacement
    - Elastic collision
    - Inelastic collision
    - deformation
    - strain
    - stress
    - von Mises stress
4. Tutorial Problem Statements

A good tutorial problem should focus on the logical steps in FEM modeling and demonstrate as many aspects of the FEM software as possible. It should also be simple in mechanics with an analytical solution available for validation. Three tutorial problems are covered in this learning module.

Tutorial Problem 1

A cylindrical rod made of 1060 aluminium alloy is subjected to an impact load of 400 m/sec in Z-direction. The length of the rod is \( l = 100 \) mm. And the diameter of the rod is 15 mm respectively. Perform a drop test analysis of the cylindrical rod using solid works 2010.

Figure 1. A Cylindrical rod subjected to impact loading.

Tutorial Problem 2

A rectangular alloy steel plate with dimensions 200 x 125 x 20 mm is assembled with a sphere of 60 mm diameter which is made up of 1060 aluminium alloy. This entire assembly is subjected to an impact loading of 250 m/sec along Z-direction. Perform a drop test analysis for the given assembly using solid works 2010.

Figure 2. A rectangular block and sphere assembly for impact loading.
Tutorial Problem 3

A sphere of 50 mm diameter made up of 1060 aluminium alloy is allowed to fall freely from a height of 1000m. Perform a drop test analysis for the given assembly using solid works 2010.

Figure 3. A sphere allowed to fall freely from a height and analyzed under drop test.
**Pre-test:**

The pre-test should be taken before taking other sections of the module. The purpose of the pre-test is to assess the user's prior knowledge in subject areas relevant to shape optimization such as Mechanics of Materials and optimization techniques. Questions are focused towards fundamental concepts including stress, strain, displacement, kinematic relationship, constitutive relationship, equilibrium, and material properties, design variables, static variables, constraints, feasible design space, evaluation space.

1. A freely falling object is subjected to one of the following:
   - O Stress
   - O Strain
   - O Displacement
   - O Acceleration due to gravity

2. What is a head on collision?

3. What is impact loading?

4. What is the difference between velocity and acceleration?

5. Drop test is basically used to determine:
   - O stress
   - O displacements
   - O both the above
   - O None of the above

6. In case of freely falling body, mass is independent of velocity of the body
   - O True
   - O False

7. State the difference between angular velocity and velocity

8. Drop test is used to test the following:
   - O hardness
   - O strength
   - O both of the above
   - O none of the above
9. What is Elastic modulus?

10. What is coefficient of restitution?
**Conceptual Analysis of Drop Test:**

Conceptual analysis for a Drop Test problem using finite element analysis reveals that the following logical steps and sub-steps are needed:

**Drop Test Study:**

1. Preprocessing
   - Geometry creation
   - Material property assignment
   - Creating setup and result options
   - Mesh generation

2. Solution
3. Post-processing
4. Validation

**Drop Test Study:**

1. Pre-processing

The pre-processing in FEM simulation is analogous to building the structure or making the specimen in physical testing. Several sub-steps involved in pre-processing are geometry creation, material property assignment, boundary condition specification, and mesh generation.

The geometry of the structure to be analyzed is defined in the geometry creation step. After the solid geometry is created, the material properties of the solid are specified in the material property assignment step. The material required for the FEM analysis depends on the type of analysis. For example, in the elastic deformation analysis of an isotropic material under isothermal condition, only the modulus of elasticity and the Poisson’s ratio are needed.

For most novice users of FEM, the boundary condition specification step is probably the most challenging of all pre-processing steps. Two types of boundary conditions are possible. The first is prescribed displacement boundary condition which is analogous to holding or supporting the specimen in physical testing. The second is applied force boundary condition which is analogous to loading the specimen. Several factors contribute to the challenge of applying boundary conditions correctly:

1) Prescribed displacement boundary conditions expressed in terms such as

\[ u_{\text{boundarya}} = \text{const} \quad \text{or} \quad \left. \frac{\partial u}{\partial x} \right|_{\text{boundaryb}} = \text{const} \]

are mathematical simplifications, and frequently only represent supports in real structures approximately. As a result, choosing a good approximate mathematical representation can be a challenge.
2) How a boundary is restrained depends also on the element type. For example, for the "clamped" or "built-in" support, a boundary should be restrained as having zero nodal displacement if solid element is used, while for the same support, the boundary should be restrained as having zero nodal displacement and zero nodal rotation if shell element is used.

3) Frequently, the structure to be analyzed is not fully restrained from rigid body motion in the original problem statement. In order to obtain an FEM solution, auxiliary restraints become necessary. Over-restraining the model, however, leads to spurious stress results. The challenge is then adding auxiliary restraints to eliminate the possibility of rigid body motion without over-restraining the structure.

Because of the above challenges, one learning module will be devoted to boundary condition specification.

Mesh generation is the process of discretizing the body into finite elements and assembling the discrete elements into an integral structure that approximates the original body. Most FEM packages have their own default meshing parameters to mesh the model and run the analysis while providing ways for the user to refine the mesh.

2. Solution

The solution is the process of solving the governing equations resulting from the discretized FEM model. Although the mathematics for the solution process can be quite involved, this step is transparent to the user and is usually as simple as clicking a solution button or issuing the solution command.

3. Post-processing

The purpose of an FEM analysis is to obtain wanted results, and this is what the post-processing step is for. Typically, various components or measures of stress, strain, and displacement at any given location in the structure are available for putout. Additional quantities for output may include factory of safety, energy norm error, contact pressure, reaction force, strain energy density, etc. The way a quantity is outputted depends on the FEM software.
Overview: In this section, three tutorial problems will be solved using the commercial FEM software SolidWorks. Although the underlying principles and logical steps of an FEM simulation identified in the Conceptual Analysis section are independent of any particular FEM software, the realization of conceptual analysis steps will be software dependent. The SolidWorks-specific steps are described in this section.

This is a step-by-step tutorial. However, it is designed such that those who are familiar with the details in a particular step can skip it and go directly into the next step.

**Tutorial Problem 1. A cylindrical rod subjected to impact loading.**

### Launching SolidWorks

SolidWorks Simulation is an integral part of the SolidWorks computer aided design software suite. The general user interface of SolidWorks is shown in **Figure 1**.

![Figure 1: General user interface of SolidWorks.](image)

In order to perform FEM analysis, it is necessary to enable the FEM component, called SolidWorks Simulation, in the software.

**Step 1: Enabling SolidWorks Simulation**

- Click "Tools" in the main menu. Select "Add-ins...". The Add-ins dialog window appears, as shown in Figure 2.
Check the boxes in both the “Active Add-ins” and “Start Up” columns corresponding to SolidWorks Simulation.

Checking the “Active Add-ins” box enables the SolidWorks for the current session. Checking the “Start Up” box enables the SolidWorks for all future sessions whenever SolidWorks starts up.

Figure 2: Location of the SolidWorks icon and the boxes to be checked for adding it to the panel.

1. Pre-Processing

Purpose: The purpose of pre-processing is to create an FEM model for use in the next step of the simulation, Solution. It consists of the following sub-steps:

- Geometry creation
- Material property assignment
- Boundary condition specification
- Mesh generation.

1.1 Geometry Creation

The purpose of Geometry Creation is to create a geometrical representation of the solid object or structure to be analyzed in FEM. In SolidWorks such a geometric model is called a part. In this tutorial, the necessary part has already been created in SolidWorks. The following steps will open up the part for use in the FEM analysis.

Step 1: Opening the part for simulation.

Download the part file “tutorial1.SLDPRT” from the web site http://www.femlearning.org/. Use the “File” menu in SolidWorks to open the downloaded part.

The SolidWorks model tree will appear with the given part name at the top. Above the model tree, there should be various tabs labeled “Features”, “Sketch”, etc. If the
“Simulation” tab is not visible, go back to steps 1 and 2 to enable the SolidWorks Simulation package.

**Step 2: Creating a Study**
- Click the “Simulation” tab above the model tree
- Click on the drop down arrow under “Study” and select “New Study” as in Figure 3
- In the “Name” panel, give the study the name “tutorial 1”
- Select “Static” in the “Type” panel to study the static equilibrium of the part under the load
- Click “OK” to accept and close the menu

![Study Menu](image)

**Figure 3: The SolidWorks “Study” menu.**

**1.2 Material Property Assignment:**

The Material Property Assignment sub-step assigns materials to different components of the part to be analyzed. All components must be assigned with appropriate material properties.

**Step 3: Opening the material property manager**
- In the upper left hand corner, click “Apply Material”.
- The “Material” window appears as shown in Figure 4.
1.3 Defining Setup:

- In the simulation study tree, right-click setup and select Define/Edit, or click Drop Test Setup (Simulation toolbar).

This will apply one material to all components. If the part is made of several components with different materials, open the model tree and apply this process to individual components.

*Figure 4: The “Material” window.*

*Figure 5: Setting up the Drop Test study*

- In the Property Manager under *Specify*, select *Velocity at impact*. 
Under **Velocity at Impact**:

a) Select the **Front Plane** from the flyout Feature Manager Design tree for **Face, Edge, and Plane for Direction**.
b) Click **Impact Velocity Reference** to select **Reverse impact velocity reference**.
c) Set the velocity units to **m/sec** and type **400** for **Velocity Magnitude**.

![Image of Drop Test Setup](image)

*Figure 6: Defining the setup for Drop test*

Under **Gravity**:

a) Select the edge shown below for **Face, Edge, and Plane for Direction**.
b) Click **Gravity Reference** to select **Reverse gravity reference**.
c) Accept the default **Gravity Magnitude**.

A vector showing the direction of gravitation appears in the graphics area.
Figure 7: Figure showing the gravity and velocity symbol vectors.

- Under Target, select Normal to gravity.
- Click OK.

1.4 To setup the result options:

1) In the Simulation study tree, right-click Result Options and select Define/Edit, or click Result Options (Simulation toolbar).

   Figure 8: Figure showing to setup the result options.

2) In the Property Manager, type 45 (in microseconds) for Solution Time after Impact.
3) The default value is calculated by the program from $3L/V_e$, where $L$ is the largest model box size and $V_e$ is the speed of the elastic wave in the material. $V_e$ is calculated as the square root of (modulus of elasticity/Density). The program internally calculates appropriate time steps that can be nonuniform.
4) Under Save Results:
   a. Type 0 for Save Results Starting From.
   b. Set No. of Plots to 30.
   c. Select <Ready> - Drop Test for Sensor List.

5) Figure 9 shows how to save results.
6) Click OK.
1.5 Mesh Generation

Purpose: The purpose of the Mesh Generation sub-step is to discretize the part into elements. The mesh consists of a network of these elements.

Step 1: Creating the mesh
- Right click “Mesh” in the model tree and select “Create mesh”
- Leave the mesh bar on its default value
- Drop down the “Advanced” menu and make sure the mesh is high quality, not draft quality, by making sure the “Draft Quality Mesh” checkbox is not clicked
- Figure 10 shows the completed mesh
- Click “OK” to close the menu and generate the mesh.

“Mesh Control” in SolidWorks may be used to refine the mesh locally. The guiding principle is to refine mesh at locations of high stress gradient, such as regions around
stress concentrators and locations of geometric changes. For the current problem, local mesh refinement is not pursued.

### 2. Solution

**Purpose:** The Solution is the step where the computer solves the simulation problem and generates results for use in the Post-Processing step.

**Step 1: Running the simulation**
- At the top of the screen, click “Run”
- When the analysis is finished, the “Results” icon will appear on the model tree

### 3. Post-Processing

**Purpose:** The purpose of the Post-Processing step is to process the results of interest. For this problem, the von Mises stress and the displacement is of interest.

**Step 1: Creating a stress plot**
- Right click “Results” on the model tree and select “Define Stress Plot”
- Select “von Mises” as the stress type and “psi” as the unit
- Unclick the “Deformed Shape” box and click “OK” to close the menu

![Figure 11: The von Mises stress plot.](image)
To animate the plot:

1. In the Simulation study tree, right-click this plot and select **Animate**.

2. Click to play the animation and click to stop the animation.

3. Click .

**Step 2: Plotting Displacement plot:**

- Select the plot for Resultant displacement.

![Displacement plot at step 30](image)

**Figure 12: The displacement plot at step 30.**

Repeat the above procedure and generate UZ displacement plot for Step number 1.
**Figure 13:** The displacement plot at step 1.

**Viewing the Results:**
- Creating Time history plot:

**Figure 14:** Creating Time History Plot.
Figure 15: Time History Plot.
Tutorial Problem 2. A sphere and a rectangular block subjected to impact loading.

Launching SolidWorks

SolidWorks Simulation is an integral part of the SolidWorks computer aided design software suite. The general user interface of SolidWorks is shown in Figure 1.

Figure 1: General user interface of SolidWorks.

In order to perform FEM analysis, it is necessary to enable the FEM component, called SolidWorks Simulation, in the software.

Step 1: Enabling SolidWorks Simulation

- Click "Tools" in the main menu. Select "Add-ins...". The Add-ins dialog window appears, as shown in Figure 2.
- Check the boxes in both the “Active Add-ins” and “Start Up” columns corresponding to SolidWorks Simulation.
- Checking the “Active Add-ins” box enables the SolidWorks for the current session. Checking the “Start Up” box enables the SolidWorks for all future sessions whenever SolidWorks starts up.
1. Pre-Processing

Purpose: The purpose of pre-processing is to create an FEM model for use in the next step of the simulation, Solution. It consists of the following sub-steps:

- Geometry creation
- Material property assignment
- Boundary condition specification
- Mesh generation.

1.1 Geometry Creation

The purpose of Geometry Creation is to create a geometrical representation of the solid object or structure to be analyzed in FEM. In SolidWorks such a geometric model is called a *part*. In this tutorial, the necessary part has already been created in SolidWorks. The following steps will open up the part for use in the FEM analysis.

*Step 1: Opening the part for simulation.*

Download the part file “tutorial2.SLDPR” from the web site http://www.femlearning.org/. Use the “File” menu in SolidWorks to open the downloaded part.

The SolidWorks model tree will appear with the given part name at the top. Above the model tree, there should be various tabs labeled “Features”, “Sketch”, etc. If the “Simulation” tab is not visible, go back to steps 1 and 2 to enable the SolidWorks Simulation package.

*Step 2: Creating a Study*

- Click the “Simulation” tab above the model tree
Click on the drop down arrow under “Study” and select “New Study” as in Figure 3.

In the “Name” panel, give the study the name “tutorial 1”.

Select “Static” in the “Type” panel to study the static equilibrium of the part under the load.

Click “OK” to accept and close the menu.

![Figure 3: The SolidWorks “Study” menu.](image)

### 1.2 Material Property Assignment:

The Material Property Assignment sub-step assigns materials to different components of the part to be analyzed. All components must be assigned with appropriate material properties.

**Step 3: Opening the material property manager**

- In the upper left hand corner, click “Apply Material”.
- The “Material” window appears as shown in Figure 4.
Figure 4: The “Material” window for sphere.

Figure 5: The “Material” window for Block.
This will apply one material to all components. If the part is made of several components with different materials, open the model tree and apply this process to individual components.

1.3 Defining Contact sets for the assembly parts:

- In the simulation study tree, right-click connections and select contact set.
- Then select “no penetration” and select the two parts in the assembly as shown in the figure 6.

![Figure 6: Defining Contact Sets.](image)

1.4 Defining Setup:

- In the simulation study tree, right-click setup and select Define/Edit, or click Drop Test Setup (Simulation toolbar).

![Figure 7: Setting up the Drop Test study](image)
• In the Property Manager under Specify, select **Velocity at impact**.
• Under **Velocity at Impact**:
  
  d) Select the **Front Plane** from the flyout Feature Manager Design tree for **Face, Edge, and Plane for Direction**.
  
  e) Click **Impact Velocity Reference** to select **Reverse impact velocity reference**.
  
  f) Set the velocity units to **m/sec** and type **250** for **Velocity Magnitude**.

![Drop Test Setup](image)

**Figure 8: Defining the setup for Drop test**

• Under **Gravity**:
  
  d) Select the edge of the block which is along z-direction for **Face, Edge, and Plane for Direction**.
  
  e) Click **Gravity Reference** to select **Reverse gravity reference**.
f) Accept the default **Gravity Magnitude**.

A vector showing the direction of gravitation appears in the graphics area.

![Gravity Symbol](image)

*Figure 9: Figure showing the gravity and velocity symbol vectors.*

- Under **Target**, select **Normal to gravity**.
- Click OK.

### 1.4 To setup the result options:

7) In the Simulation study tree, right-click **Result Options** and select **Define/Edit**, or click **Result Options** (Simulation toolbar).

*Figure 10: Figure showing to setup the result options.*

8) In the Property Manager, type **200** (in microseconds) for **Solution Time after Impact**.

9) The default value is calculated by the program from $3L/V_e$, where $L$ is the largest model box size and $V_e$ is the speed of the elastic wave in the material. $V_e$ is
calculated as the square root of (modulus of elasticity/Density). The program internally calculates appropriate time steps that can be nonuniform.

10) Under Save Results:
   
   d. Type 0 for Save Results Starting From.
   e. Set No. of Plots to 25.
   f. Select <Workflow Sensitive1> - Drop Test for Sensor List.

11) Figure 9 shows how to save results.
12) Click OK.

1.5 Mesh Generation

Purpose: The purpose of the Mesh Generation sub-step is to discretize the part into elements. The mesh consists of a network of these elements.

Step 1: Creating the mesh
   o Right click “Mesh” in the model tree and select “Create mesh”
   o Leave the mesh bar on its default value
   o Drop down the “Advanced” menu and make sure the mesh is high quality, not draft quality, by making sure the “Draft Quality Mesh” checkbox is not clicked
   o Figure 10 shows the completed mesh
   o Click “OK” to close the menu and generate the mesh.
“Mesh Control” in SolidWorks may be used to refine the mesh locally. The guiding principle is to refine mesh at locations of high stress gradient, such as regions around stress concentrators and locations of geometric changes. For the current problem, local mesh refinement is not pursued.

2. Solution

Purpose: The Solution is the step where the computer solves the simulation problem and generates results for use in the Post-Processing step.

Step 1: Running the simulation
- At the top of the screen, click “Run”
- When the analysis is finished, the “Results” icon will appear on the model tree

3. Post-Processing

Purpose: The purpose of the Post-Processing step is to process the results of interest. For this problem, the von Mises stress and the displacement is of interest.

Step 1: Creating a stress plot
- Right click “Results” on the model tree and select “Define Stress Plot”
- Select “von Mises” as the stress type and “psi” as the unit
- Unclick the “Deformed Shape” box and click “OK” to close the menu
**Figure 13:** The von Mises stress plot.

To animate the plot:

1. In the Simulation study tree, right-click this plot and select **Animate**.

2. Click ⌚️ to play the animation and click ⏬ to stop the animation.

3. Click ✓.

Click to play the video file:

*Step 2: Plotting Displacement plot:*

- Select the plot for Resultant displacement.
**Figure 14**: The displacement plot at step 1.

Repeat the above procedure and generate UZ displacement plot for Step number 25.

**Figure 15**: The displacement plot at step 25.
Viewing the Results:

- **Creating Time history plot:**

  ![Procedure to define Time History plot.](image1)

  **Figure 16:** Procedure to define Time History plot.

  ![Creating Time History Plot.](image2)

  **Figure 17:** Creating Time History Plot.
Figure 18: Time History Plot.
Tutorial Problem 3. A sphere freely falling from some height subjected to drop test.

Launching SolidWorks

SolidWorks Simulation is an integral part of the SolidWorks computer aided design software suite. The general user interface of SolidWorks is shown in Figure 1.

![General user interface of SolidWorks.](image)

In order to perform FEM analysis, it is necessary to enable the FEM component, called SolidWorks Simulation, in the software.

**Step 1: Enabling SolidWorks Simulation**

- Click "Tools" in the main menu. Select "Add-ins...". The Add-ins dialog window appears, as shown in Figure 2.
- Check the boxes in both the “Active Add-ins” and “Start Up” columns corresponding to SolidWorks Simulation.
- Checking the “Active Add-ins” box enables the SolidWorks for the current session. Checking the “Start Up” box enables the SolidWorks for all future sessions whenever SolidWorks starts up.
1. Pre-Processing

**Purpose:** The purpose of pre-processing is to create an FEM model for use in the next step of the simulation, Solution. It consists of the following sub-steps:

- Geometry creation
- Material property assignment
- Boundary condition specification
- Mesh generation.

1.1 Geometry Creation

The purpose of Geometry Creation is to create a geometrical representation of the solid object or structure to be analyzed in FEM. In SolidWorks such a geometric model is called a *part*. In this tutorial, the necessary part has already been created in SolidWorks. The following steps will open up the part for use in the FEM analysis.

*Step 1: Opening the part for simulation.*

Download the part file “tutorial3.SLDPR” from the web site http://www.femlearning.org/. Use the “File” menu in SolidWorks to open the downloaded part.

The SolidWorks model tree will appear with the given part name at the top. Above the model tree, there should be various tabs labeled “Features”, “Sketch”, etc. If the “Simulation” tab is not visible, go back to steps 1 and 2 to enable the SolidWorks Simulation package.

*Step 2: Creating a Study*

- Click the “Simulation” tab above the model tree
Click on the drop down arrow under “Study” and select “New Study” as in Figure 3.

In the “Name” panel, give the study the name “tutorial 1”.

Select “Static” in the “Type” panel to study the static equilibrium of the part under the load.

Click “OK” to accept and close the menu.

Figure 3: The SolidWorks “Study” menu.

1.2 Material Property Assignment:

The Material Property Assignment sub-step assigns materials to different components of the part to be analyzed. All components must be assigned with appropriate material properties.

Step 3: Opening the material property manager

- In the upper left hand corner, click “Apply Material”.
- The “Material” window appears as shown in Figure 4.
This will apply one material to all components. If the part is made of several components with different materials, open the model tree and apply this process to individual components.

1.3 Defining Setup:

- In the simulation study tree, right-click setup and select Define/Edit, or click Drop Test Setup (Simulation toolbar).

- In the Property Manager under Specify, select Velocity at impact.
- Under Velocity at Impact:
g) Select the **Front Plane** from the flyout Feature Manager Design tree for **Face, Edge, and Plane for Direction**.

h) Click **Impact Velocity Reference** to select **Reverse impact velocity reference**.

i) Set the velocity units to **m/sec** and type **400** for **Velocity Magnitude**.

---

**Figure 6: Defining the setup for Drop test**

- **Under Gravity:**
  
  g) Select the edge shown below for **Face, Edge, and Plane for Direction**.
  h) Click **Gravity Reference** to select **Reverse gravity reference**.
  i) Accept the default **Gravity Magnitude**.

  A vector showing the direction of gravitation appears in the graphics area.

- **Under Target**, select **Normal to gravity**.
- Click OK.

**1.4 To setup the result options:**

13) In the Simulation study tree, right-click **Result Options** and select **Define/Edit**, or click **Result Options** (Simulation toolbar).
Figure 7: Figure showing to setup the result options.

14) In the Property Manager, type 45 (in microseconds) for Solution Time after Impact.
15) The default value is calculated by the program from 3L/V_e, where L is the largest model box size and V_e is the speed of the elastic wave in the material. V_e is calculated as the square root of (modulus of elasticity/Density). The program internally calculates appropriate time steps that can be nonuniform.
16) Under Save Results:
   
g. Type 0 for Save Results Starting From.
h. Set No. of Plots to 30.
i. Select <Ready> - Drop Test for Sensor List.

17) Figure 9 shows how to save results.
18) Click OK.

Figure 8: Defining the result options.

1.5 Mesh Generation

Purpose: The purpose of the Mesh Generation sub-step is to discretize the part into elements. The mesh consists of a network of these elements.

Step 1: Creating the mesh
Right click “Mesh” in the model tree and select “Create mesh”

Leave the mesh bar on its default value

Drop down the “Advanced” menu and make sure the mesh is high quality, not draft quality, by making sure the “Draft Quality Mesh” checkbox is not clicked

Figure 10 shows the completed mesh

Click “OK” to close the menu and generate the mesh.

“Mesh Control” in SolidWorks may be used to refine the mesh locally. The guiding principle is to refine mesh at locations of high stress gradient, such as regions around stress concentrators and locations of geometric changes. For the current problem, local mesh refinement is not pursued.

2. Solution

Purpose: The Solution is the step where the computer solves the simulation problem and generates results for use in the Post-Processing step.

Step 1: Running the simulation

- At the top of the screen, click “Run”
- When the analysis is finished, the “Results” icon will appear on the model tree

3. Post-Processing

Purpose: The purpose of the Post-Processing step is to process the results of interest. For this problem, the von Mises stress and the displacement is of interest.

Step 1: Creating a stress plot

- Right click “Results” on the model tree and select “Define Stress Plot”
- Select “von Mises” as the stress type and “psi” as the unit
Click the “Deformed Shape” box and click “OK” to close the menu.

Figure 10: The von Mises stress plot.

To animate the plot:

1. In the Simulation study tree, right-click this plot and select **Animate**.

2. Click ✪ to play the animation and click ✅ to stop the animation.

3. Click ✅.

Step 2: Plotting Displacement plot:

- Select the plot for Resultant displacement.
Repeat the above procedure and generate UZ displacement plot for Step number 1.

**Figure 11:** The displacement plot at step 1.

**Figure 12:** The displacement plot at step 25.
Viewing the Results:

- **Creating Time history plot for Displacement:**

![Time History Graph](image)

**Figure 13:** Creating Time History Plot for displacement.

![Time History Plot](image)

**Figure 14:** Time History Plot for displacement.
• **Creating time-history plot for velocity:**

![Image of Time History Graph]

**Figure 15:** Creating Time History plot for Velocity.

![Image of Time History plot]

**Figure 16:** Time History plot for Velocity.
Validation of Results:

From FEA results, we can observe the velocity of the sphere is 140 m/sec. Now we calculate the analytic results:

Instantaneous velocity $v_i$ of a falling object that has travelled distance $d$:

$$v_i = \sqrt{2gd}$$

$$v_i = \sqrt{2 \times 9.8 \times 2000}$$

$$= 140 \text{ m/sec}$$

Hence the results from FEA and Analytic analysis are matched perfectly.
Attachment E. Post-test

2. A freely Falling object is subjected to one of the following:
   - Stress
   - Strain
   - Displacement
   - Acceleration due to gravity

2. What is a head on collision?

3. What is impact loading?

4. What is the difference between velocity and acceleration?

5. Drop test is basically used to determine:
   - stress
   - displacements
   - both the above
   - None of the above

6. In case of freely falling body, mass is independent of velocity of the body
   - True
   - False

7. State the difference between angular velocity and velocity

8. Drop test is used to test the following:
   - hardness
   - strength
   - both of the above
   - none of the above

9. What is Elastic modulus?

10. What is coefficient of restitution?
Attachment F. Assessment

- Do you feel it was bad to not have a teacher there to answer any questions you might have?
  - O It didn’t matter
  - O It would have been nice
  - O I really wanted to ask a question

- How did the interactivity of the program affect your learning?
  - O Improved it a lot
  - O Improved it some
  - O No difference
  - O Hurt it some
  - O Hurt it a lot

- The six levels of Bloom’s Taxonomy are listed below. Rank how well this learning module covers each level. 5 meaning exceptionally well and 1 meaning very poor.

1. Knowledge (remembering previously learned material)
   - O 5
   - O 4
   - O 3
   - O 2
   - O 1

2. Comprehension (the ability to grasp the meaning of the material and give examples)
   - O 5
   - O 4
   - O 3
   - O 2
   - O 1

3. Application (the ability to use the material in new situations)
   - O 5
   - O 4
   - O 3
   - O 2
   - O 1
4. Analysis (the ability to break down material into its component parts so that its organizational structure may be understood)
   O  5
   O  4
   O  3
   O  2
   O  1

5. Synthesis (the ability to put parts together to form a new whole)
   O  5
   O  4
   O  3
   O  2
   O  1

6. Evaluation (the ability to judge the value of the material for a given purpose)
   O  5
   O  4
   O  3
   O  2
   O  1

- Do you think the mixed text and video format works well?
  O  Yes
  O  Indifferent
  O  No

- Do you think the module presents an affective method of learning FEA?
  O  Yes
  O  Indifferent
  O  No

- Did you prefer this module over the traditional classroom learning experience? Why or why not.
• How accurate would it be to call this module self-contained and stand-alone?
  O Very accurate
  O Accurate
  O Indifferent
  O Inaccurate
  O Very inaccurate

• What specifically did you like and/or dislike about the module.

• How useful were the practice problems?
  O Very helpful
  O Helpful
  O Indifferent
  O Unhelpful
  O Very unhelpful

• Was there any part of the module that you felt was unnecessary or redundant? Was there a need for any additional parts?

• Please list any suggestions for improving this module.

• Overall, how would you rate your experience taking this module?
  O Excellent
  O Fair
  O Average
  O Poor
  O Awful
Attachment G. Practice Problems

1) Repeat the tutorial 1 with the gravity symbol inverted. And perform the drop test analysis and compare the results with the results from tutorial 1.
2) Repeat the tutorial 2 with the gravity symbol inverted. And perform the drop test analysis and compare the results with the results from tutorial 2.
3) Repeat the tutorial 3 with the gravity symbol inverted. And perform the drop test analysis and compare the results with the results from tutorial 3.